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As an attorney, you often 

spend your time running 

from one client’s crisis to 

the next. There’s always an 

emergency to deal with, and 

as a result, computer train-

ing is relegated to the back 

burner. The problem this 

situation poses is that com-

puters have become such an 

integral part of law offices 

that you’re doing yourself 

(and possibly your cli-

ents) a disservice 

by not master-

ing at least the 

fundamentals. 

 

In order to help you 

assess your place on 

the literacy spectrum, 

we’ve prepared a multi-

ple choice quiz covering 

what we consider to be the 

basics. If you flunk misera-

bly, you might want to take 

a beginner’s course at the 

local community college or 

buy an entry-level book. If 

you pass with flying colors, 

congratulations. Be careful, 

there are plenty of places to 

lose points. We recommend 

reading the questions and 

answers carefully. Usually, 

there is more than one 

correct answer, i.e., (a) 

and (c). You must try to 

pick ALL the correct an-

swers. 

Scoring. Each correct an-

swer is worth a point and 

there are 17 possible points. 

Subtract one point for each 

incorrect answer you 

marked as correct. Do not 

subtract a point for correct 

answers that you failed to 

mark. For 

example, if the correct 

answers to a question were 

(a) and (c) and you picked 

only (a), you would score 

one point for picking (a). 

Your failure to also select 

(c) would not count against 

you. However, if you picked 

(a) and (b), you would add a 

point for the correct selec-

tion and subtract one for 

picking a wrong answer (b). 

Finally, don’t take this test 

in front of a computer. It’s 

not an open book test! 

14 to 17 – You pay atten-

tion to details and you’re 

aware there’s more than one 

way to perform any task. In 

terms of the basics, you 

qualify as a nerd or geek. In 

recognition of your achieve-

ment, you should wrap 

some tape around the bridge 

of your eyeglasses.  

 

9 to 13 – The nerds 

may think you’re 

not worth a pocket 

protector, but at 

least, on average, 

you were able to 

pick at least one 

correct answer 

with respect to each 

of the nine areas cov-

ered. Not bad.  

 

5 to 8 – Weak. Remember, 

this isn’t rocket science; it’s 

the basics. At five points 

you barely have half of the 

nine areas covered. If you 

got eight points you’re not 

so bad, but at five, yikes! 

 

4 or less – You’re a support 

technician’s nightmare. You 

make a five-minute call last 

an hour. Why are you work-

ing in a law office? You 

should be asking people 

whether they want their 

order super-sized. Good-
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Points of Interest  

Å Housing & Urban 

Development 
Forms (HUD). See 
page 13 for details 
about this latest re-
lease AND its SU-
PER, INTRODUC-
TORY PRICE! 

Å Check out all the 

available free up-
grades on page 17. 

Å More Borland Database 

Engine information on 
page 18. 
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bye. 

(Continued from page 1) 

LAW  OFF IC E  CO MP UTE R  
L I TE R AC Y    

ñWe recommend 

reading the 

questions and 

answers carefully. 

Usually, there is 

more than one 

correct answer, i.e., 

(a) and (c). You 

must try to pick ALL 

the correct 

answers.ò 
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The Questions 

 

1. You’re in Windows Explorer and you have a file named ―MYFILE.DOC‖ highlighted. If 

you want to delete the file, which of the following statements are correct? 

a. Press the Delete key on your keyboard. 

b. You cannot delete files from Windows Explorer. 

c. Right-click your mouse and pick Delete from the pop-up menu. 

d. With both mouse buttons down and your head about eight inches from the com-

puter speaker, clearly say, ―I command you to delete.‖ 

 

2. Since the earliest DOS days, computer file names have had extensions. Which of the fol-

lowing statements about extensions are correct? 

a. They are the part of the file name that follows the period. 

b. They are the part of the file name that precedes the period. 

c. They usually denote a file’s type. 

d. They are small, or rubber feet that you can place under your hard drive as protec-

tion against static electricity. 

 

3. Almost every Windows program has a File menu with a Save command and a Save As 

command. In connection with these two commands, which of the following statements are 

correct? 

a. The two commands are identical. 

b. Save saves your file to the hard drive; Save As saves your file to the floppy 

drive. 

c. Save As sometimes permits you to save your file in a different file format. 

d. Save saves your file using the file’s current name; Save As lets you choose a 

different name for saving the file. 

 

4. You’re in Windows Explorer, you have a file named ―MYFILE.DOC‖ highlighted, and 

you want to give it a new name. Which of the following statements is correct? 

a. Press m  on you keyboard and type the new name. 

b. Trace a circle counterclockwise around the file name with your mouse cursor and 

then type the new name. 

c. You cannot rename files from Windows Explorer. 

d. Press the Delete key on your keyboard; in the confirmation dialog, select No and 

then type the new name. 

 

5. In connection with the Internet, which of the following are correct? 

a. You visit a Web site by typing the URL, i.e., www.puritas-springs.com, in the 

Address box of your browser. 

b. Uploading is the process of copying a file from somewhere on the Internet to your 

own computer. 

c. A self-extracting file is a file that must be decompressed or unzipped using utility 

software like WINZIP. 

d. Downloading is the process of copying a file from somewhere on the Internet to 

your own computer. 

 

6. You need to find a file named ―MYFILE.DOC‖ and you know it’s somewhere on your 

hard drive, but you don’t know where. Which of the following is the best way to find it? 

a. Ask someone in the office who knows something about computers. 

 

b. Click the Start button, then Find, then Files and Folders é. In the Find dialog 

enter MYFILE.DOC in the Named field; leave Containing text blank; and make 
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AR E  YOU  TH E  WEA K E S T  L I N K? 
(CON Tõ) 

ñScoring. Each 

correct answer is 

worth a point and 

there are 17 

possible points. 

Subtract one point 

for each incorrect 

answer you marked 

as correct.ò  
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sure C:\My Documents is in the Look in field. 

c. Click the Start button, then Find, then Files and Folders …. In the Find dialog 

enter MYFILE.DOC in the Named field; leave Containing text blank; and make 

sure C:\ is in the Look in field. 

d. Click the Start button, then Find, then Files and Folders …. In the Find dialog 

enter *.DOC in the Named field; in the Containing text field type: MY-
FILE.DOC; and make sure C:\ is in the Look in field. 

 

7. In Windows Explorer and many other Windows programs, the result of left-clicking the 

mouse is different when the j  or b  keys are held down. Which of the following are 

correct? 

a. Both j  and b  are alternate ways of performing the same selection. 

b. If you make a selection in a list and then select a different item while holding the 

b  key down, the first item you selected, the second item you selected and each 

item in between will be selected. 

c. If you make a selection in a list and then select a different item while holding the 

j  key down, the first item you selected, the second item you selected and each 

item in between will be selected. 

d. If you make a selection in a list and then select a different item while holding the 

b  key down, the first item you selected and the second item you selected will 

both remain selected, but the items in between will not be selected. 

 

8. In just about any Windows program, especially word processors, the ability to copy and 

paste text is a great timesaver. On the subject of copying and pasting, which of the follow-

ing are correct? 

a. The hot-key combination for the copy function is:  bC . 

b. The hot-key combination for the paste function is:  bV . 

c. Another set of hot-keys that work for copying and pasting, respectively, are: 

bh  and jh . 

d. The copy function is invisible in that it transfers the selected text to an area of 

memory Windows refers to as the Clipboard. In other words, you don’t really see 

anything happen! 

 

9. You’re in Windows Explorer, you have a file named ―MYFILE.DOC‖ highlighted, and you 

want to move it to a floppy. Which of the following statements is correct, assuming your 

floppy drive is designated as A:? 

a. Click the Edit menu and select the Move command. 

b. Click the Edit menu and select the Copy command; then, browse to the A:\ drive 

and click the Edit menu and select the Paste command. 

c. You need a move utility; you cannot move files in Windows Explorer. 

d. Click the Edit menu, and select the Cut command; then, browse to the A:\ drive 

and click the Edit menu and select the Paste command. 

 

10. Which of the following statements are true in connection with help files and manuals? 

a. On a day when it’s not too windy, manuals make good kindling. 

b. When all else fails, you should look to the manuals and help files for clues. 

c. Manuals and help files are written by people who need help, but not with respect 

to computing. 

d. All of the above. 

L A W  O F F I C E  C O M P U T E R  L I T E R A C Y  
A R E  Y O U  T H E  W E A K E S T  L I N K ?  (C O N Tõ)   

ñ é if you didnôt at 

least choose (a) and 

(b), you can only be 

helped by calling 

Miss Cleo for a free 

reading.ò  
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Is There A Sign On My 
Back?  
 

We visited www.drugstore.com 

last year and got some pretty 

good deals on non-

prescriptive medications, 

vitamins and other supple-

ments. Hey, this web 

surfin’s fun. And we’re 

savin’ money too! On our 

second visit to the site we 

were understandably willing 

to buy a membership card 

that provided the user an 

additional 20% off future 

purchases. When the card 

arrived in the mail a few 

days later we noticed that 

the card was only good for 

one year and could only be 

used on the first Tuesday of 

each month. If that wasn’t 

bad enough, the next time 

we visited the site we no-

ticed that prices for the vari-

ous items we had purchased 

were raised—you guessed 

it—20%! After takin’ it on 

the bum again, we felt like 

visiting www.underwear.com so 

we could obtain shorts with 

a readily accessible back 

entrance. 

 

In Case You Think No 
Oneôs Paying Attention 

 

We once searched ―Human 

Growth Hormone‖ in the 

search vehicle of one site. 

Not a day had passed before 

we received the first unso-

licited e-mail from a sepa-

rate company selling—you 

guessed it—Human Growth 

Hormone. Try searching the 

word ―bankruptcy‖ and see 

what happens. It may be 

best to do this on the com-

puter of someone you don’t 

like.

A Legend In His Own 
Mind  
 

Our technical guru Ernie 

was thrilled to get a call 

from Whoôs Who indicating 

he’d been nominated for 

inclusion. The call started 

innocently enough by ask-

ing for a few bits of back-

ground information, but 

after offering up numerous 

bits of personal information, 

it began to take the tone of a 

sales call. When the caller 

got to the part where she 

wanted Ernie to purchase a 

subscription, he knew he’d 

been had! We usually give 

unsolicited sales calls an 

immediate disconnect; how-

ever, this one not only 

avoided the fast flush, but 

also had Ernie gushing like 

he was being interviewed by 

Barbara Walters. 

 

That Catôs Got Credit 
 

Two issues ago, we did an 

article on free Internet ser-

vices providers. They’re just 

about all gone now, but not 

before they gathered per-

sonal information about 

their users and quietly stud-

ied their browsing habits. 

Heck, some of them seemed 

to fold right after the 10-

page enrollment application 

was completed. That should 

have been a clue, huh? 

Thank God we didn’t an-

swer the questions truth-

fully. Gee whiskers, we 

hope it doesn’t skew the 

results of their marketing 

study. At any rate, we got a 

chuckle when Ernie enrolled 

his cat. We roared when, 

one month later, Snuggles 

was pre-approved for a 

Platinum VISA! 
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ñAt any rate, we got 

a chuckle when 

Ernie enrolled his 

cat. We roared 

when, one month 

later, Snuggles was 

preapproved for a 

Platinum VISA!ò 

 D I G I TAL  IN K LI N GS  

Get It Right Or  
Pay The Price  
 

After reading our issue on 

free Internet Service Provid-

ers, we received an e-mail 

from Attorney Mark A. 

Rock: 

 
I read the Free Internet article, 

and observed that you failed to 

mention one of the more impor-

tant considerations when select-

ing an e-mail provider. That is the 

ability to handle attachments, to 
handle them with a minimum of 

fuss, AND, to permit an attach-

ment size of up to 10 megs. Some 

providers do not permit attach-

ments, others max out at 2 MB, 

and only a few allow a full 10 MB. 

 

Everything you say is true, 

but because the field of free 

ISP’s has thinned so, I doubt 

we’ll do a sampling of e-

mail attachment constraints. 

Free or not, readers would 

be well-advised to inquire 

about e-mail limitations 

before signing with an ISP. 

This was the very reason we 

switched from e-mailing 

upgrades to making 

downloads available. Too 

many customers were either 

not receiving the attachment 

or in some cases of AOL 

users, the zipped file was 

being automatically un-

zipped and to the user’s 

surprise, they were receiv-

ing a hundred little unzipped 

files instead of the one large 

zipped file we told them to 

expect. Naturally, the 

download procedure is eas-

ier and less consumptive of 

Internet resources. 
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New Statement of Affairs,  
Schedule E and Proof of 
Claim Forms  
 
January 1, 2001 saw the 
first of two modifications to 
the Bankruptcy Forms.  The 
first involved changes to 
Form 7, the Statement of 
Financial Affairs. As per the 
Judicial Conference: 
 
ñThe form has been 
amended to provide addi-
tional information requested 
by taxing authorities, pen-
sion fund supervisors, and 
governmental units charged 
with environmental protec-
tion and regulation. Four 
new questions have been 
added to the form. The new 
questions concern: 
 

¶ community property and  

non-filing and former 
spouses, 

¶ environmental issues, 

¶ any consolidated tax 

group of a corporate 
debtor; and 

¶ the debtorôs contributions 
to any employee pension 
fund.ò 

In addition, every debtor will 
be subjected to a look-back 
period of six years instead of 
the old two-year period. 

 
In a subsequent announce-
ment, the Administrative 
Office of the United States 
Courts also changed Sched-
ule E and the Official Form 
10, Proof of Claim. 
 

Notice to Individual Con-
sumers  
 
We added the Notice of Indi-
vidual Consumers to our list 
of included forms. Youôll find 
the complete set of revised 
and added forms on the next 
page. 
 
New Features  
 
Updating forms was a ne-
cessity, but we did even 
more to automate the proc-
ess. One new feature is 
WBank3ôs ability to auto-
matically calculate the 
unsecured portion of 
debts included on Sched-
ule D . 
 
WBank3 can also automati-
cally select the appropri-
ate exemption set.  Talk 
about cool features ð
WBank3 has the ability to 
download the latest pro-
gramming upgrades from 

P A R T I A L  F E A T U R E  L I S T  

OFFI CI AL  BAN KRU PTC Y  FORM S  

exemption editor for 
changing existing exemp-
tion tables or creating new 
ones 

¶ Contains a master credi-

tor database for perma-
nent storage of often-used 
creditorsô names and ad-
dresses 

¶ Electronic creditorsô 
matrixðcreate the 
creditor matrix on disk for 
jurisdictions requiring or 
accepting electronic 
matrices 

¶ More help and tutorial 
information than ever 
before 

¶ Compatible with the elec-

tronic filing protocol used 
by U.S. Bankruptcy courts 

¶ Integrated worksheets 

organize and consolidate 
your information, (i.e.., 
you complete our work-
sheets and WBank3 com-
pletes the forms) 

¶ Visit our web site to 
download a free demo  

¶ Prepares the standard 

Official Bankruptcy Form 
set for Chapters 7, 11, 12 

and 13 bankruptcies 

¶ Stands -alone as a 
program needing no spe-
cial word processing or 
other software to generate 
printed forms 

¶ Our new Interview Wiz-
ard doesnôt require exten-
sive knowledge about 
program operation 

¶ Print -shop -perfect forms 

on laser, inkjet or even dot 
matrix printers 

¶ Calculates Schedule C 
exemptions automati-
cally and includes an 

Page 6  Volume 2002,  Issue  1  
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Form 1 Voluntary Petition & Exhibit A Form 7 Statement of Financial Affairs 

Form 2 Declaration ... Form 8 Statement of Intentions 

Form 3 Application & Order to Pay ... Form 9 Notices of Commencement 

Form 4 Creditors Holding 20 Largest ... Form 10 Proof of Claim 

Form 5 Involuntary Petition Form 11A General Power of Attorney 

Form 6 Instructions Form 11B Special Power of Attorney 

 Summary of Schedules Form 12 Order & Notice on Hearing 

 Schedule AðReal Property Form 13 Order Approving Disclosure ... 

 Schedule BðPersonal Property Form 14 Ballot for Accepting/Rejecting 

 Schedule CðExemptions Form 15 Order Confirming Plan 

 Schedule DðSecured Creditors Form 17 Notice of Appeal 

 Schedule EðPriority Creditors Form 18 Discharge of Debtor 

 Schedule FðUnsecured Creditors Form 19 Certification of Non-Attorney 

 Schedule GðExecutory Contracts Misc Matrix of Creditors (OCR) 

 Schedule HðCodebtors B203 Disclosure of Compensation 

 Schedule IðCurrent Income Misc Business Debtorôs Inc./Exps. 

 Schedule JðCurrent Expenditures Form 20A Notice of Motion 

 Declaration Concerning Schedules Form 20B Notice of Motion 

  Misc Notice to Individual Consumers 

Law Off ice Computing  

programs. When you try our 
new bankruptcy program, 
youôll wish every program 
you own used this approach! 
 
ððððððððððð 

 
Official Bankruptcy Forms 
for Windows (WBank3) is a 
32-bit Windows application 
that runs in Windows 
XP/2000/ME/98/95 & NT 
operating systems. Because 
WBank3 is a true 32-bit 
application, it does not run in 
Windows 3.1 or Windows for 
Workgroups 3.11. 
 
WBank3 requires a Pentium 
or equivalent processor with 
at least 16 MB of RAM. 
WBank3 requires between 4 
and 12 megabytes of hard 

Bankruptcies can be compli-
cated. If they werenôt, peo-
ple wouldnôt need attorneys 
for them. Puritas Springs 
Software  believes that even 
if the legal issues are com-
plex, the software doesnôt 
need to be. As usual, Puri-
tas Springs Software is a 
leader in adapting our soft-
ware to incorporate the 
freshest and most important 
trends in development. 
 
Weôre not talking about 
change for the sake of 
change, but change that 
enhances the userôs soft-
ware experience and em-
powers a user to work more 
efficiently. Our new Inter-
view Wizard  will change the 
way you work with computer 

disk space. WBank3 works 
best with a SVGA video card 
with a minimum of 256 colors 
and display resolution capa-
bilities of 800 x 600 pixels. 
WBank3 runs on any Win-
dows-compatible printer. 
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ñBankruptcies can 

be complicated. If 

they werenôt, people 

wouldnôt need 

attorneys for them. 

Puritas Springs 

Software believes 

that even if the legal 

issues are complex, 

the software doesnôt 

need to be.ò 
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With U.S. Estate Tax 
(W706), we followed the 
Puritas Springs Software 
philosophyðthat is building 
an easy-to-use and rea-
sonably priced program spe-
cially created for small and 
medium-sized law offices. 

 

So if you only handle the 
estates of billionaires or 
have more money than 
brains, you may want to buy 
a $1,000 estate tax pro-
gram; but if you prepare 
estate tax returns for the 
other 99% of estates, youôll 
love our program and youôll 
love its special price  of 

P A R T I A L  F E A T U R E  L I S T  

UN I T ED  STAT E S  ES TAT E  TAX  

information that you can 
effortlessly change, de-
lete, insert, append and 

sort . 

G Check Return function 
reviews nearly 100 rules 
and reminders for testing 
a tax return prior to print-
ing. 

G Tutorial  included in the 
printed manual for step-
ping beginners through a 
sample estate tax return. 

G Upgrades available by 
download ðyou can stay 
up-to-date on late-
breaking changes by 
downloading your up-
grade from our web site.  
Any day of the week, any-
time of the day or night. 

G Network Version Avail-
able . Makes network in-
stallation, maintenance 
and use easier than ever 
before. 

G Visit www.puritas -
springs.com for a free 

downloadable demo . 

G For familiarity and ease of 
navigation, screens look 
exactly like their Form 706 
paper counterparts. 

G IRS-approved printed 
forms look print -shop -
perfect on any Windows 
compatible printer. 

G All calculations are per-
formed dynamically and 
automatically. This is not 
a word processor or 
spreadsheet template that 
must be completed manu-
ally or that requires addi-
tional software or hard-
ware to generate printed 
returns. 

G Context -sensitive help  
means you can highlight a 
menu command, press l  
and go straight to the re-
lated help topic. The help 
files contain a complete, 
hyperlinked copy of the 
Form 706 instructions , 
in addition to the complete 
text of Pub 950 ï Intro-
duction to Estate & Gift 
Taxes. 

G Over 20 new custom 
continuation pages for 
better organization and a 
more comprehensible 
final product. 

G Worksheets for entering 
beneficiaries, assets and 
debts. Each allows you to 
work with centrally located 

ñ... if you only 

handle the estates of 

billionaires or have 

more money than 

brains, you may 

want to buy a 

$1,000 estate tax 

program; but if you 

prepare estate tax 

returns for the other 

99% of estates, 

youôll love our 

program and youôll 

love its special 

price ...ò 
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Young Holmes had just 
graduated from law school, 
been accepted to a large 
firm, moved into this new 
office and was awaiting his 
first client. As he sat at his 
desk contemplating his hard 
work and the good fortune it 
had reaped, he heard foot-
steps coming down the hall 
headed for his office. 
Quickly, he picked up the 
phone and began talking. 
 
ñWell,ò said Holmes, ñIôm 
very busy right now, and 
Iôve got to be in court this 
afternoon because Iôm start-
ing a trial. Perhaps I can 
squeeze you in some eve-
ning next week.ò 
 
Holmes hung up the phone 
and, turning to the man 
standing at the doorway, 
asked ñYes, can I be of help 
to you?ò 
 
ñNo thanks,ò the man re-
plied, ñI just came to con-
nect your phone.ò 

I N  G O O D  H U M O R  
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FO R  W IN DOW SñFORM  706  

ñU.S. Gift Taxð

Youôll be impressed 

by what you get for 

$49.99.ò 

Form 706 U.S. Estate Tax Return - pgs 1-3 Sched L Net Administration Losses  

Sched A Real Estate Sched M Bequests, etc. to Spouse 

Sched A-1 Section 2032A Valuation - 4 pgs Sched O Charitable, Public & Similar Gifts 

Sched B Stocks and Bonds Sched P Credit for Foreign Death Taxes 

Sched C Mortgages, Notes and Cash Sched Q Credit for Tax on Prior Transfers 

Sched D Insurance on the Decedentôs Life Sched R GST Tax - 3 pgs 

Sched E Jointly Owned Property Sched R-1 GST Tax 

Sched F Other Miscellaneous Property Sched T Family-Owned Business 

Sched G Transfers During Decedentôs Life Sched U Conservation Easement Exclsn 

Sched H Powers of Appointment Wrksht TG Taxable Gifts Reconciliation 

Sched I Annuities Wrksht TG Taxable Gifts Reconciliation 

Sched J Funeral and Administrative Exps. Ln 9 Wrkst Gift Tax on Gifts After 1976 

Sched K Debts of the Decedent ... Sch Q Wkst Credit for Tax on Prior Transfers 

The U.S. Gift Tax for Win-
dows (W709)  program is a 
companion to our U.S. Es-
tate Tax (W706) program. 
W709 includes all the forms, 
schedules and automated 
continuation schedules  
listed in the box to the right. 
Youôll be impressed by what 
you get for $49.99! Like all 
our new programs, W709 is 
a 32-bit Windows program 
that is compatible with Win-
dows XP/2000/ME/98/95 & 
NT operating systems. We 
also have a network ver-
sion available that makes it 
possible to centrally locate 
your client tax files for easy 
backup and file synchroniza-
tion. W709 takes care of all 
the calculations and prints 
beautiful, IRS-approved 
forms and schedules. Donôt 
forget that you can 
download a free demo from 
our website.  

U N I T E D  S TA T E S  G I F T  T A XñF O R M  7 0 9  

Form 709 U.S. Gift (and GST) Tax Return 

Sched A Computation of Taxable Gifts 

Sched B Gifts from Prior Periods 

Sched C Computation of GST Tax 

Form 709-A U.S. Short Form Gift Tax Return 

Sched A Continuation Page for Part 1 ... 

Sched A Continuation Page for Part 2  ... 

Sched B Continuation for Gifts From Prior Periods 

Sched C Continuation for Part 1ðGST 

Sched C Continuation for Part 1ðSpouseôs Split Gifts 

Sched C Continuation for Part 3ðTax Computation 

Form 709-A Continuation Schedule 

Included Forms  
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Networks ! That, in a word, 
is the founding principle 
upon which this package 
was built. Thereôs two sig-
nificant advantages to that 
design philosophy. First, 
name and address, 
bookkeeping, billing and 
calendar data is synchro-
nized for the entire office . 
Did you ever change a 
clientôs address and then 
run from computer to 
computer making sure 
everyone in your office had 
the change? Not so with the 
Law Office Management 
Pack . Files are centrally 
located so changes by one 
user are seen by all. Sec-
ond, centrally located files 
make it easy to backup all 
your data files because 
everything is on one 
computer. 
 
BookBase3 Reporting . 
Now you have more ways to 
get back what you enter. 
Search for information 
inclusively or exclusively on 
any field with instant, on-
screen results. Sortable on 
any field. Plus a Report 

Creator that generates text 
files (viewable in any word 
processor) for formatting 
and printing. BBase3 lets 
you filter data to select any 
range of dates, include any 
or all accounts or trans-
actions as designated by 
search text, payor/payee, 
income or expense 
categories and subtotaling 
by year/month or by 
category, payee or account. 
 
Calendar/Docketing . This 
module is like getting an 
extra program for free. 
BillBase3 now lets you 
keep simple calendar 
information with additional 
room for notesðsearchable 
and printable. 
 
Stop Watch . Is your 
work ever interrupted 
with phone calls, 
unscheduled 
meetings, etc.? Now you 
can keep track of your time 
with a stop watch on your 
Windows task bar. The timer 
can be started, stopped and 
reset, so itôs helpful for 
tracking of billable hours. 

Start Me Up . Unfortunately, 
billing/bookkeeping systems 
need more setup than other 
software. Fortunately, the 
Office Management Pack 
has a Getting Started  
Wizard that will take care of 
creating name and 
bookkeeping files and 
linking all the software 
packages together. 
 
Context Sensitive Help . If 
you need help with a 
command, just highlight it 
and press the l key. 
Instantly, youôll be viewing 
the help topic for that 
command. Other page 
components also have 
context-sensitive help and 

informative error 
messages.  
 
SYSTEM 
REQUIREMENTS: 
Windows XP/2000/

ME/98/95/NT with 16MB of 
memory (32 MB recom-
mended). Requires a SVGA 
monitor capable of display-
ing 256 colors with minimum 
display resolution of 
800x600 pixels. 

Word for 
Windows word 
processors; a 
fast and easy 
way to paste 
names and 
addresses into 
letters and 
eliminate the 
chance of 
misspelling a 
name or making 
a mistake in an address. 

( Prints  laser sheet 
address labels (Avery 
No. 5160), continuous 
feed dot matrix address 

( Auto -Dialer . CBASE3  
not only looks up the 
phone number for you, 
but it also dials it. All you 
have to do is pick up the 
receiver and have 
something to say (fax/
modem card and 
intelligent conversation 
not included). 

( Auto -Addresser feature 
- pastes formatted 
names and addresses  
into other Windows 
programs capable of 
clipboard interaction 
such as WordPerfect or 

labels (Avery No. 4013), 
telephone directories  
and full format name and 
address hard copies. 

LAW  OFFIC E  MANAGE M EN T  

C L I E N T B A S E  
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& Check Printing in the 
standard printer 
configuration of one 
check per sheet with the 
check in the middle 
position. 

& Inserts dates and check 
numbers  automatically 
for speedier data entry. 

& Intelliguesses 
bookkeeping entries as 
you begin typing. 

& Maintains and balances 
separate accounts. 

& Choose recurring entries 
from history lists. 

& Customizable  income 
class and expense 
account labels for 
tailoring the system to 
your law practice. 

& Extensive search, 
select and 
segregation 

capabilities . 

& Improved sorting and 
search capabilities. 

& Expanded  reporting 
criteria generates 
viewable, printable 
reports; compatible 
with word 

processors . 

positioned for folding 
and placement in a 
window envelopeðno 
more typing envelopes. 

±Prints and itemizes 
any additional charges 
to the clientôs bill since 
the last bill, i.e., filing 
fees, transcript costs, 

etc. 

±Prints and credits any 
client payments made 
since the date of the 
last bill (or any date you 
choose). 

±Contains up to five 
optional fill -in fields 
for special entries such 
as initial retainers or 
client discounts. 

±Calculates and prints 

±Starts with a balance 
forward that is 
transferred from the 
clientôs prior monthôs 
bill. 

±Prints your personal 
letterhead ðno more 
pricey, special billing 
stationery; BillB3 uses 
ordinary 8 1/2 x 11 pa-
per. 

±Looks up the clientôs 
full name and address 
and prints it on their bill 

a present balance 

due.  

±Calculates a new 
balance forward and 
creates a new billing 
file for the next 

month.  

±Preview  individual bills 
on screen prior to 
printing. 

±Prepare and date -
sorts your  itemized 
statements  so that 
they can be 
incorporated into the 
monthly billing state-
ment. 

±A calendar  feature lets 
you access a 
searchable and 
printable daily/hourly 
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B I L LBAS E  

BO O KBAS E  

log for scheduling court 
appearances, client 
appointments, 
meetings, you name it!  

±You can add 
customized special 
notes to bills with notifi-
cation of repeat billings, 
upcoming court dates, 
facilitate payment by 
credit card, etc. 

±If you choose, you can 
add interest on 
unpaid balances  that 
are carried from month-
to-month. 

±Donôt forget that the 
Office Management 
Pack is available as a 
free demo. Give us a 
call and request your 
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$49.99  

How can we sell a 1041 
program for $49.99? Be-
cause we designed it spe-
cifically for small-to medium- 
sized law offices doing sim-
ple returns for small-to me-
dium- sized estates and 
trusts. Of course, if your 
Form 1041 tax returns typi-
cally involve super complex 
estate or trust tax issues, 
you may be required to bite 
the bullet and buy a super 

expensive, overpriced pro-
gram that has training 
courses, annual mainte-
nance fees and a plethora of 
little-used bells and whistles. 
Our thinking is that these 
programs are overkill for law 
offices because law offices 
usually outsource those 
types of returns anyway. For 
the other 99% of returns, our 
new W1041 fits the bill per-
fectly! 

I R S  F I L I N G  R E Q U I R E M E N T  

UN I TE D  STA T E S  IN C OM E  TA X  
FO R  ES TA TE S  & TRU ST S  

Even if youôre not handling 
million dollar estates, itôs 
hard to find one that doesnôt 
meet the filing criteria. At a 
price of $49.99, W1041 
pays for itself as soon as 
you do your first return . All 
forms and schedules are 
approved by the IRS. 

The Tax Code requires 
Form 1041 to be filed by 
nearly every estate or trust 
with a federal identification 
number. The regulations 
provide : 
 
ñThe fiduciary (or one of 
the joint fiduciaries) must 
file Form 1041 for a do-
mestic estate that has 
gross income for the tax 
year of $600 or more.ò 

ñThe fiduciary é 

must file Form 

1041 for a domestic 

estate that has a 

gross income for 

the tax year of $600 

or more.ò 
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I N C L U D E D  F O R M S  &  S C H E D U L E S  

Form 1041 U.S. Income Tax for Estates & Trusts 

Schedule A Charitable Deduction 

Schedule B Income Distribution Deduction 

Schedule D Capital Gains & Losses w/continuation pages 

Schedule G Tax Computation 

Schedule I Alternative Minimum Tax 

Schedule J Accumulation Distribution for Complex Trust 

Schedule K-1 Beneficiaryôs Share 

Form 1041-A U.S. Information Return 

Form 1041-ES Estimated Tax Worksheet 

Form 1041-ES Estimated Tax Vouchers 

Form 1041-QFT U.S. Income Tax Return for Qualified Funeral ... 

Form 1041-T Allocation of Estimated Tax Payments ... 
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ñé law office 

personnel typically 

run from one crisis 

to another and 

rarely have time to  

sharpen their 

computer skills. 

Despite this 

deficiency, thereôs 

one facet of 

computing that law 

office personnel 

know better than 

anyone elseðand 

thatôs word 

processing.ò 

HUD FO RM S  FO R  W IN D OW S  

office staffers usually know 
their word processor inside-
out, and do more than sim-
ply type business letters. 
Masters of form and func-
tion, law offices churn out 
letters, reports, notes, plead-
ings, motions, memoranda, 
briefs and more. Thatôs 
where WHUD shines be-
cause it connects seam-
lessly with any word proces-
sor capable of opening RTF 
files. Microsoftôs Word for 
Windows, Corelôs WordPer-
fect and even the generic 
WordPad work just fine. 
Therefore, all previewing 
and printing is done via your 
own word processor. What 
can be easier? 
 
Have It Your Way ðYou 
can change and format the 
completed HUD forms in 
your word processor any 
way you want. And you donôt 
need any special paper or 
other supplies to generate 
print-shop-perfect forms, 
because WHUD is designed 
to print forms using any Win-
dows-compatible printer on 
ordinary, blank legal-size (8 
1/2 x 14) paper. Thereôs 
more! You can do more than 
just modify the completed 
forms, you can also open 
the program form templates 
and make global modifica-
tions to customize WHUD to 
produce forms your way . 
Finally, you may have en-

countered HUD programs 
that wonôt let you enter text 
where amounts are ex-
pected. WHUD doesnôt have 
that limitation, so if you 
wanted to make such notes 
or explanatory comments, 
WHUD wonôt force you to do 
otherwise. 
 
Everything But The 
Kitchen Sink ðThere are 
over 1,600 HUD forms and 
related FHA, Fannie Mae, 
WH and EPA forms. Only 
the HUD Forms 1 and 1A 
are automated as described 
above, but WHUD also con-
tains almost all of the 1,600 
odd forms. Most are in a 
PDF format, but some are 
interactive in either Microsoft 
Word for Windows (doc) or 
Excel (xls) formats.  
 
And Then Thereôs The 
PriceðIf you want to do 
some easy research, type 
ñHUD softwareò in your fa-
vorite search engine. Among 
the tens of thousands of 
hits, youôre sure to find a few 
companies that provide 
HUD software. Visit the sites 
and look at their prices. 
Youôll be amazed at the 
prices that range from $200 
to $300 and higherðand 
they donôt provide any more 
functionality than our 
WHUD! That makes WHUD 
a true ñBest Buyò at $99.99! 

Hereôs the newest addition 
to our library of legal soft-
wareðHUD Forms for Win-
dows (WHUD). This pro-
gram packs more value for 
your dollar than perhaps any 
other title in our catalog. 
 
Weôre Listening To You 
 
We have nearly 5,000 users 
of Puritas Springs Soft-
ware products and, small 
company that we are, we 
know our customers and 
listen to what they say. 
 
Over the years, weôve had 
more requests for a HUD 
program than perhaps any 
other legal software pack-
age we are capable of deliv-
ering. In the words of the 
Chambers Brothers, ñTime 
Has Come Today.ò 
 
Program Features  
 
What You See Is What You 
GetðYou wonôt need train-
ing manuals or instructional 
courses to learn how to use 
WHUD. The Settlement 
Statement appears on your 
screen looking just like it 
does on paper. You simply 
tab from field to field enter-
ing your information and let 
WHUD crunch all the num-
bers. Calculations are auto-
matic and instantaneous. All 
updating is done dynami-
cally as quickly as you can 
enter the numbers. 
 
What Law Offices Know 
BestðLaw offices can be 
surprisingly challenged 
when it comes to computer 
technology. Thatôs because 
law office personnel typically 
run from one crisis to an-
other and rarely have time to 
sharpen their computer 
skills. Despite this defi-
ciency, thereôs one facet of 
computing they know better 
than anyone elseðand 
thatôs word processing. Law 
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Background  
 
During the development and 
release process of Deed 
and Document Pro for 
Windows (WDeed) , we 
knew we were breaking 
new, exciting ground in 
automated document prepa-
ration. It was immediately 
apparent that WDeed was 
light years ahead of its 
predecessors in terms of 
reliability, utility and ease of 
use. After the release of 
WDeed, our first impres-
sions were confirmed by our 
usersðafter all, thatôs the 
ultimate test. That was the 
framework upon which we 
built our new Living Trust 
and Estate Planning  
(WTrust ). 
 
WordPerfect and Word for 
Windows ï Word Proces-
sor Compatibility  
 
WTrust lets you do all your 
formatting, previewing and 
printing in your word proces-
sor. For touch typists, this is 
a major breakthrough. Be-
cause law office computing 
is 90% word processing, 
what could be more comfort-
able and user-friendly than 
to use your word processor 
to format and print WTrust 
documents? Character for-
matting such as Old English 
fonts, special paragraph 
formatting, manipulation of 
page breaks, and text edit-
ing in general, including 
spell checking and grammar 
checking, is all a piece of 
cake once youôre in your 
word processor. Further-
more, the link between 
WTrust and your word proc-
essor is quick, easy, seam-
less and invisible. Just one 
mouse click! 
 

Breaking the Code  
 
WTrust permits users to go 
into the program to set up 
documents specifically for 
their office. A particular deed 
or document may change 
slightly from state to state or 
even from county to county 
based on local custom and 
practice. The design of our 
new WTrust takes this need 
into consideration by letting 
you break into the program 
document templates them-
selves and customize them 
just about any way you 
want. If, for example, you 
always use special language 
in your revocable living 
trusts, WTrust gives you 
access to the program tem-
plates. By modifying these 
templates, you can insert 
your handcrafted clauses 
into WTrust  itself. There-
fore, every new document 
you create contains your 
language automatically. 
 
Setting the Defaults  
 
We took one more step to 
speed up the document 
creation process. The docu-
ment templates are one 
thing, but thereôs also the 
matter of ñfilling in the 
blanks.ò Thereôs a good 
amount of information that 
does not change from docu-
ment to document. A typical 
example may involve insert-
ing an attorneyôs name, ad-
dress and telephone number 
as preparer of a particular 
document. To expedite this 
process, we designed 
WTrust to allow you to set 
certain default information 
that is part of the document 
but not part of the template 
so that you donôt need to 
reenter information in the 
Document Wizard (see next 
page) that rarely, if ever, 
changes. 
 

The Problem and the Solu-
tion  
 
Living trust software seems 
to fall into two categories: 
bargain basement stuff de-
signed by idiots for idiots, 
and extremely expensive 
and complicated packages 
designed to plan the estates 
of Donald Trump or the 
Rockefellers. If youôre look-
ing for trust software for your 
typical small- to medium-
sized law office that serves 
ordinary people, youôll have 
to look long and hard and 
you probably wonôt find any-
thing! We spent hours on 
the Internet and found zilch. 
 
Living Trust and Estate 
Planner for Windows 
(WTrust ) was created to fill 
the chasm between these 
two extremes. Itôs an ex-
traordinary program de-
signed for ordinary estates. 
WTrust does not stop with 
the trust forms. WTrust also 
contains many of the compli-
mentary documents that are 
necessary or useful in com-
pleting the estate plan. 
WTrust has a pour-over will 
for catching property or as-
sets that never made it to 
the trust estate, a certificate 
or abstract of trust for dis-
closing the existence of the 
trust and parties while main-
taining privacy. This is one 
of the advantages of trusts. 
WTrust also contains a vari-
ety of documents for trans-
ferring property to the trust 
estate such as deeds and 
bill of sale, and a compli-
ment of other documents 
such as living will declara-
tion, durable power of attor-
ney for health care and gen-
eral durable power of attor-
ney. See the complete list 
on the following page. 
 

L I V I N G  TRU ST  AND  

ñItôs easy to walk 

out of an estate 

planning seminar 

with more questions 

than you walked in 

with.ò 
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Document Wizards  
 
You wonôt struggle with 
WTrust . The Document 
Wizards take you through 
each document by asking 
simple questions, by provid-
ing examples of the informa-
tion required and by sug-
gesting answers based on 
your worksheet entries. 
When youôve completed the 
Wizard, WTrust completes 
the document by inserting 
your information in the 

proper places. Moreover, 
WTrust  analyzes hundreds 
of places in the documents 
where there are nouns, 
verbs, adverbs, etc., and 
makes sure that every inser-
tion is grammatically correct. 
One of the most common 
problems with lengthy docu-
ments like trusts is that law 
offices have worked with 
them for so long and so of-
ten, the documents are 
nearly immune to proofread-
ing. Furthermore, spelling 
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ES TATE  PLAN N ER  

ñThe majority of 

clients who are 

interested in and 

may benefit from a 

living trust are not 

millionaires.ò 

Trusts 
& Wills  

Revocable Living Trust ï A Style  Transfer 
Docments  

Warranty Deed  

Revocable Living Trust ï AB Style  Warranty Deed w/Survivorship  

 Pour -Over Will   Quit -Claim Deed  

 Certificate/Abstract of Trust   Bill of Sale  

Misc.  Living Will Declaration  

www.puritas -springs.com   Power of Atty - Health Care  

 General Power of Attorney  

Windows XP/2000/ME/98/95/NT . WTrust is a 
32-bit Windows program. It will run in Windows 
XP/2000/ME/98/95 or NT. It will not run in Win-
dows 3.1, Windows for Workgroups 3.11 or any 
other 16-bit Windows operating system. 

Windows Copy/Paste Compatibility . If you 
have a lengthy legal description in your word 
processor, you  can utilize WTrustôs Copy/
Paste functions to copy and paste to or from 
any Windows program. 

Word Processor Compatibility . WTrust is 
compatible with any word processor that can 
open rich text format (RTF) files which includes 
Microsoftôs Word, Corelôs WordPerfect and even 
Windowsô generic WordPad. 

Tool Bar. Not that you donôt have the menu 
bar and pop-up menus for performing com-
mon functions, weôve included a tool bar to 
provide one-click implementation of the most 
common program commands. 

Context -Sensitive Help . You can press l  on 
any menu item and many other window objects 
and instantly receive help related to that com-
mand or object. The same is true for many other 
window components. 

Pop-Up Menus . Right-click your mouse to 
access pop-up menus for common functions 
such as saving files, starting new files and 
previewing and printing documents. 

Balloon Hints . Rest your cursor on a button or 
window object and a help window appears, giv-
ing you information about that buttonôs or ob-
jectôs function. 

 

A D D I T I O N A L  F E A T U R E S  

checkers donôt know when 
the word ñofò is misspelled 
as the word ñor.ò Conse-
quently, itôs easy for gram-
matical errors to be over-
looked when preparing 
these documents. WTrust 
solves that problem by giv-
ing you a complete docu-
ment you can ð well, trust. 
That saves you from embar-
rassment when a client actu-
ally reads the document at 
home and finds mistakes, 
however incongruous. 
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Search  
Engines  
 
 

 
Sure, practically everything 
imaginable can be found on 
the Internet. Thatôs why they 
call this the Information Age. 
The trick is finding things 
and search engines are the 
means to that end. Hereôs a 
list we compiled of some top 
contenders: 
 
www.alltheweb.com  
Just another web site for 
searching the Internet. It 
produces an enormous 
number of hits. It doesnôt 
strive to compete for home 
page status, and itôs no 
worse or better than any of 
the other engines in the lot. 
 
www.av.com  
This is one of our old favor-
itesðAltaVista. It has an 
advanced search feature 
(most worthy search en-
gines do) and generates a 
large number of hits. 
 
www.ask.com  
This is the Ask Jeeves 
search site. Itôs neat from 
the standpoint that you can 
ask questions in ordinary 
English like, ñWhere is An-
chorage?ò It has come up 
with sites that AltaVista ei-
ther missed or buried. Just 
donôt expect too much from 
its ability to parse your ques-
tions. Rather than producing 
scads of insignificant hits, 
Ask Jeeves seemed to gen-
erate meaningful hits and 
also suggested related 
searches. 
 
www.excite.com  
Like AltaVista, Excite would 
like you to make it your 
home page and has custom-
izable features that let you 
gather stock, weather and 
shopping information. 

www.google.com  
Nothing flashy about 
Google, just a simple search 
engine that produces a lot of 
hits. This site earned PC 
Magazineôs Editorsô Choice 
award. 
 
www.ixquick.com  
Another very simple site with 
the typical normal and ad-
vanced search features. 
Again, itôs no better or worse 
than any other of the big ten. 
 
www.lycos.com  
Lycos is another of the older 
engines that provides more 
than just your typical search 
engine. It has a customiza-
ble interface that provides 
news, weather, etc. 
 
www.northernlight.com  
Aside from the cool name, 
Northern Light has all the 
goodiesðadvanced search 
capability, customizable 
interface, etc. This site also 
earned PC Magazineôs Edi-
torsô Choice award. 
 
www.oingo.com  
Aside from the name (at 
least itôs not www.dogpile.com), 

itôs another neat search en-
gine with limited home page 
appeal. 
 
www.yahoo.com  
Hey, if youôve never heard of 
Yahoo, you must be from 
another planet. It has every-
thing the others have and 
then some. 
 
How do these sites com-
pare? We designed a simple 
and arbitrary test. We 
searched ñunited states 
codeò  to see (1) whether 
the code text would be at 
the top of the hit list, (2) how 
many hits would be gener-
ated and (3) would a search-
able code site be among the 
top results. 

Hereôs the results: 
 
AllTheWebð3,803,656 hits; 
including code text and 
search page. 
 
AltaVista ð411,041 hits; 
including code text and 
search page. 
 
Ask Jeeves ðdoesnôt dis-
close the number of hits; 
includes code text and 
search page; also produced 
collateral searches that 
seemed relevantðin this 
case: codes, states, state 
codes, U.S. law and more. 
Donôt discount this site be-
cause of low hits. We felt 
this was one of the better 
search engines although PC 
Magazine didnôt agree. 
 
Exciteð3,730,465 hits; 
including code text and 
search page. 
 
Googleð2,030,000 hits; 
including code text and 
search page. 
 
IXQuickð3,883,644 hits; 
including code text and 
search page. 
 
Lycosð2 hits; huh? Whatôs 
this one doing in the top 10? 
 
Northern Light ð2,230,386 
hits; included code text, but 
search page did not make 
the top 10. 
 
Oingoðexcelled at crashing 
our computer; weôd pass on 
this one. 
 
Yahooð25 sites; including 
code text and search page. 
 
Donôt be fooled by numbers 
alone. Ask Jeeves didnôt 
flaunt its numbers, yet had 
perhaps the most relevant 
results. Also donôt forget 
www.findlaw.com which 

we discussed in the last 
issue. 

WE B  S I T ES  & RE L ATE D  NEWS  

Start Your Engines 

 

www.av.com 

www.ask.com 

www.excite.com 

www.alltheweb.com 

www.google.com 

www.ixquick.com 

www.lycos.com 

www.northernlight.com 

www.oingo.com 

www.yahoo.com 
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ñDownloadable 

UpgradesðEligible 

users with Internet 

service can contact 

us for information 

about downloading 

upgrades from our 

Web site. Note that 

our newer programs 

can download 

upgrades 

automatically by 

using the Help 
menuôs Download 
Upgrade item.ò  

UPDATE  NOT I CE S ,  ETC .  

Bankruptcy Alert  
 
There were two form 
changes in calendar year 
2001 that affected the Bank-
ruptcy program. The first 
was changes to the State-
ment of Affairs. The second 
was changes to the limits on 
unsecured priority claims on 
Schedule E. These changes 
are important. If you have 
Version 2 or earlier, you 
should purchase the up-
grade. If you have Version 
3, the upgrade is free. Fol-
low the instructions in the 
box to the right and request 
your upgrade right away. 
 
U.S. Estate Tax Reminder  
 
Remember, you donôt need 
to pay to upgrade the W706 
program every year, but you 
do need to monitor the maxi-
mum unified credit based on 
the date of death. Below is a 
table of the values through 
2006. 

Ohio Estate Tax  
 
Like its federal counterpart, 
the Ohio Estate Tax credit 
changes on 1/1/2002, at 
which time the value in-
creases from $6,600 to 
$13,900. You can make this 
change yourself by overrid-
ing line 5 of Form 2. Contact 
us sometime after that date 
for any additional changes 
becoming effective on 
1/1/2002. 

Revised Ohio Child  
Support Guidelines  
 
There were significant 
changes to the Ohio child 
support worksheets in 2001. 
The first was Senate Bill 180 
(3/22/2001) which changed 
the worksheet and rendered 
all versions before Version 4 
obsolete. Second was 
House Bill 94 (9/5/2001) 
which made a major correc-
tion to errors in Senate Bill 
180. If you have any Version 
before Version 4, you should 
purchase the upgrade im-
mediately. If you have any 
Version 4.xx lower than Ver-
sion 4.18, you should follow 
the instructions in the box to 
the right and request your 
free upgrade immediately. 
 
Living Trust & Estate Plan-
ner/Deed & Document Pro  
 
Both of these programs con-
tain a Living Will Declaration 
and Durable Power of Attor-
ney for Health Care and 
both were affected by the 
addition of ñDo Not Resusci-
tateò language. Check your 
version. 
 
Checking Your Version 
Number  
 
You can check your version 
number by starting your 
program and clicking on the 
Help menuôs About item. In 

the About Dialog , usually at 

the top, you will see the 
complete version number. 
 
Downloadable Upgrades  
 
Eligible users with Internet 
service can contact us for 
information about download-
ing upgrades from our Web 
site. Note that our newer 
programs can download 
upgrades automatically by 
using the Help menuôs 
Download Upgrade item. 

The following programs are 
eligible for a free upgrade 
until the release of a sub-
sequent major upgrade . 
Send your original program 
disk(s) (no Borland disks or 
manuals), and include a 
self -addressed, stamped 
return mailer . The version 
numbers in bold are current 
as of publication.  
 
WARNING: Sorry,  we 
cannot be responsible for 
returning disks that are 
ineligible. 
 
Official Bankruptcy Forms  
- Version 3.55  - versions 
between 3.00 and 3.54. 
 
U.S. Estate Tax - Version 
3.20 - any version between 
3.00 and 3.19. 
 
U.S. Income Tax for 
Estates and Trusts ï 
Version 4.17  -  any version 
between 4.00 and 4.16. 
 
Adoption of Minors - 
Version 1.11  - any version 
between 1.00 and 1.10. 
 
Basic Ohio Probate Forms 
- Version 4.09 - any version 
between 4.00 and 4.08. 
 
Ohio Estate Tax - Version 
4.58 - any version between 
4.00 and 4.57. 
 
Revised Ohio Child 
Support Guidelines 
Version 4.18  -  any version 
between 4.00 and 4.18. 
 
Ohio Wrongful Death & 
Minorôs Claims ï Version 
2.05 -  any version between 
2.00 and 2.04. 
 
Ohio Guardianship Forms 
ï Version 2.24  ï any 
version between 2.00 and 
2.23. 

Year 
Maximum 

Unified Credit 

1999 $211,300 

2000 & 2001 $220,500 

2002 & 2003 $229,800 

2004 $287,300 

2005 $326,300 

After 2005 $345,800 
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Q.1. An error occurs when 
we install our program 
indicating the BDE was 
unable to merge the con-
figuration file. Why are we 
getting this error?  
 
Q.2. Our program installed 
without a problem, but we 
get an error when we try 
to start it; the error is re-
lated to the BDE. Whatôs 
causing this error?  
 
A.  Both of these questions 
have the same answer. As 
we mentioned in a prior is-
sue, over 50% of our techni-
cal support questions relate 
to the Borland Database 
Engine (BDE) so an expla-
nation of the BDE benefits 
most users. 
 
When we mentioned that the 
BDE has over five million 
users, we neglected to men-
tion that Corelôs WordPer-
fect Office Suite also uses 
the BDE. Consequently the 
five million user estimate is 
probably way low because 
Corel users account for over 
five million users by them-
selves. Letôs face it, even 
though WordPerfect is a 
dying word processor, thirty 
or so percent of law offices 
that we talk to still use it and 
that in itself accounts for 
plenty of users. 
 
The history of the Borland/
Corel relationship is that 
they originally entered into a 
joint venture of sorts in order 
to compete with Microsoftôs 
Office. Corel bought Word-
Perfect and Borland bought 
the other components like 
the spreadsheet program 
(Quattro Pro) and the data-
base component (Paradox). 
On paper this probably 
looked like a good idea, but 
these different programs 
from different companies 
never quite jelled together 
like the Microsoft products 

that were designed almost 
from the outset to work with 
one another. To make mat-
ters worse, after a year or 
two, Corel and Borland went 
their separate ways. Com-
bine this with the fact that 
Microsoft Office usually 
came on new computer sys-
tems for ñfreeò and it spelled 
ñshrinking salesò for Corelôs 
Office Suite. 
 
Back to the questions. One 
problem that we see with 
some regularity is a configu-
ration file merge error when 
installing some of our pro-
grams. We understand that 
the error results from a bug 
in the BDE version that Bor-
land gave to Corel and we 
have two relatively simple 
ways to fix the problem. 
 
The first method is to 
download an update from 
the Borland web site. Weôve 
had a few offices call us and 
tell us that this worked very 
well. Just download and 
install the update and youôre 
ready to reinstall the Puritas 
Springs  program. At the 
time of this writing, the up-
grade file could be found at: 
 
www.borland.com/devsupport/bde/
bdeupdate.html 

 
The download (Version 
5.1.1) is a self-extracting 
single file named 
bde511en.exe . Note that we 

also have the file available 
for download from our web 
site (on our Downloads 
page) in case the situation 
changes with Borland (after 
all, in the last few years 
theyôve changed their name 
from Borland to Inprise and 
then back to Borland again). 
 
The second fix is the Puri-
tas Springs  method. Itôs the 
brute force method, mean-
ing it ainôt pretty, but it gets 
the job done. It involves 

following the three steps 
explained below. 
 
First , find the 16-bit and 32-
bit versions of the BDE on 
your computer. You can find 
the 16-bit version by search-
ing your hard drive for a file 
named BDECFG.EXE. Make 

a note of the folder that you 
find it in. Usually itôs a folder 
on your C drive named 
C:\IDAPI . Itôs not always 
there, so you should do a 
Search/Find for it. Another 

reason to search for it is that 
sometimes the BDE violates 
its own rules and installs 
itself twice on the same 
drive when it is only sup-
posed to install once. The 
next part to step one is to 
find the 32-bit version. 
Search/Find for BDEAD-
MIN.EXE. The 32-bit version 

can be in a number of 
places. Weôve found it in the 
following: 
 
C:\Program Files\Borland 

and  
C:\Program Files\Common Files\ 
Borland Shared 

and 
C:\Corel\OfficeX\Shared\IDAPI 
and 
C:\Program Files\Corel\SuiteX\Shared\ 

IDAPI 

 
Weôve also found it in other 
locations, so itôs very impor-
tant that you do a Search/
Find for it. Again, note the 

locations where you find it. 
 
Second , you must delete 
every folder that you find 
either the 16-bit or 32-bit 
BDEs. Not only must you 
delete the folders that they 
are in, you must also empty 
your Recycle Bin when 

youôre done making the de-
letions. When you install/
reinstall the BDE, it looks for 
itself over the entire hard 
drive, and thatôs why itôs 

(Continued on page 19) 
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though WordPerfect 

is a dying word 
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so percent of law 
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to still use it and 

that in itself 

accounts for plenty 

of users.ò 
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important to empty the Re-
cycle Bin. If you donôt, the 
BDE will attempt to update 
the copy in the Recycle Bin. 

 
Third , reinstall the BDE 
using the compact disk or 
floppies that you obtained 
from Puritas Springs . Both 
the 16-bit and 32-bit BDEs 
can be downloaded from the 
Downloads page of our 

web site (www.puritas-

springs.com). After you install 

the program(s) and reboot, 
you can test your program
(s) by starting them up. If the 
program starts without an 
error message, youôre done. 

(Continued from page 18) 

If you have some interest, 
you can contact Copeland 
Enterprises, Inc. at 216-214-
7082. 
 
Keep up the fine work. 
 
A satisfied customer, 
 
Carl F. Gillombardo, Jr., 
Esq. 
 
We havenôt noticed a degra-
dation in print quality al-
though we have noticed the 
print heads have a short-
ened life expectancy. We 
have two comments to make 
in this regard. First, the sav-
ings in ink greatly outweighs 
the increase in print head 
wear and tear. Second, ink 
cartridges seem so grossly 
overpriced, your suggestion 
would seem well worth in-
vestigating for offices that 
wish to avoid the messy 
business of refilling car-
tridges. 
   
Oops Re: BDE  
 
Your instructions regarding 
the download of BDE 5.1.1 
from [Inprise] are in error. 
You say to uninstall the BDE 
prior to installing the 
downloaded file. This does 
not work because the 
downloaded file is an UP-
GRADE and will not install if 
you have removed the BDE. 
However, simply applying 
the upgrade and then install-
ing [your program] does 
work successfully. Thought 
you may want to know. 
 
Lindsay Evans, Sys Admin 
Lake Co Prosecutorôs Office 
 
We are very appreciative of 
the feedback and apologize 
for the misinformation. As 
punishment for being impre-
cise in writing the BDE por-
tion of the manual, we are 
installing a screen saver on 
Ernieôs computer that will 

make him think his computer 
has a virus. Heôll be scratch-
ing his head ótill the cows 
come home before he fig-
ures this one out. 
 
Technical Support  
In Ernest  
 
I just wanted to thank you 
for all the help you have 
given me when Iôve called 
with computer questions 
[about] updating our soft-
ware and recently request-
ing [Form] 706 information. 
It certainly makes my job 
easier knowing I can count 
on you and the friendly staff 
at Puritas Springs. I am 
grateful for your expertise 
and willingness to help. 
Thank you. 
 
Jennifer Foltz, Paralegal 
Betzel & Kauffman 
 
You must have caught Ernie 
on a good day. Heôs usually 
not that nice. Because of 
you he campaigned for an 
Inbox page and whined until 
we included your note. 
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ñYour instructions 

regarding the 

download of BDE 

5.1.1 from [Inprise] 

are in error. You say 

to uninstall the BDE 

prior to installing 

the downloaded file. 

This does not work 

because the 

downloaded file is 

an UPGRADE and 

will not install if 

you have removed 

the BDE.ò  

Regarding Reinking  
 
I am the owner of your soft-
ware and I just received 
Issue 1 of Volume 2001. The 
writing, whether it be that of 
Mr. Zore or someone else, is 
incredibly good. It blends 
casualness with intelligent, 
hard-hitting commentary. 
 
With reference to the re-
inking article, please know 
that one of my clients is a 
certified MBE whose prod-
ucts include recycled-
remanufactured tone car-
tridges which are produced 
according to the stringent 
ISO 9002 quality standards. 
They may be the best com-
bination of lower price and 
better-than-new perform-
ance. Over a period of time, 
you may find that simply re-
inking destroys the quality of 
your print. Moreover, by 
federal law a recycled prod-
uct does not void the manu-
facturerôs warranty whereas 
merely reinking might. 
 

W E I R D  W E B  
S T U F F  

Every so often a contro-
versy arises over the char-
acters one finds in Micro-
softôs symbol fonts, for ex-
ample Wingdings. A user e-
mailed with this truly curi-
ous observation. Take a 
look at what happens when 
you type the flight number 
of one of the infamous 
World Trade Center jets: 
 
1. Open Word and type the flight 
number Q33NY. 
 

2. Select what you have typed and 
enlarge the font to 26 points or 
larger. 
 

3. Change the font to Wingdings. 
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U.S. Estate Tax  
Schedule O  
 
ñHow can I make an entry 
on Schedule O; itôs not 
listed on the Asset/Debt 
worksheet with the rest of 
the schedules?ò 
 
During an unfortunate lapse 
in judgment, Schedule O 
was thought to be ñmore 
beneficiary orientedò and 
therefore, its entries are on 
the Beneficiary worksheet 
instead of the Asset/Debt 
worksheet that covers the 
rest of the schedules. 
 
All 32 -Bit Programs  
File Names  
 
ñSometimes after I save 
my client file, I canôt find it 
in the directory where Iôm 
sure I saved it. Whatôs 
happening to my files?ò 
 
Actually nothing is happen-
ing to your files. The suspect 
files are avoiding you be-
cause youôre putting periods 
in your file names. Donôt do 
that! If you want to give your 
file a name like ñJohn D 
Smithò make sure you donôt 
put a period after the middle 
initial. Hereôs whatôs been 
happening. One of the won-
derful things about Windows 
9X and later operating sys-
tems was their ability to per-
mit long file names. If you 
can remember the DOS 
days, youôll remember that 
all file names had to be in an 
8+3 format. That is, the file 
name could not exceed 8 
characters and the name 
was followed by a period 
and then a 3-character ex-
tension. When Windows 95 
came along, it did away with 
the 8-character file name 
limitation and instituted the 
following rule:  
 
A file name can contain up to 215 
characters, including spaces. How-

ever, it is not recommended that you 
create file names with 215 charac-
ters. Most programs cannot interpret 

extremely long file names. File names 
cannot contain the following charac-
ters: \ / : * ? " < > | .  
 

Youôll notice that periods (.) 
are accepted characters in 
Windows file names and 
thatôs part of the problem. In 
DOS, in 16-bit Windows and 
even in the present 32-bit 
Windows varieties, the pe-
riod signifies the beginning 
of the extension. The exten-
sion is a part of the file 
name that is typically three 
characters in length and 
usually designates the file 
type. A TXT extension, for 
example, denotes a text file; 
a DOC extension usually 
represents a Microsoft Word 
document, etc. Your prob-
lem occurred because the 
program was misinterpreting 
the period you inserted after 
the middle initial ñDò in the 
file name ñJohn D Smithò as 
the beginning of the exten-
sion. Another thing to notice 
is that Windowsô standard 
open and save dialogs filter 
out or mask files that do not 
match the file type. There-
fore, after you saved your 
file, the program was hiding 
your file because it treated 
everything after the first pe-
riod as part of the file type or 
extension. Recent versions 
of our 32-bit programs now 
handle this situation cor-
rectly, but we still advise you 
to avoid putting periods in 
your file names in order to 
avoid other potential prob-
lems. You can check 
whether a particular pro-
gram can accept more than 
one period in a file name by 
trying to save a test file us-
ing the name ñJohn D. 
Smith.ò If you can save the 
file without an error, youôre 
halfway there. After saving 
it, try opening it. If it opens 
without an error, you have a 

corrected version of the pro-
gram. If not, you can follow 
the instructions on the Up-
grade Notices page (p. 17), 
assuming you fit the up-
grade criteria set forth on 
that page. 
 
BillBase3  
Credit Card Transactions  
 
ñWhen we prepare a bill, 
we paste the following text 
into the note section of 
the Billing Entry Form:  
 
Credit Card No.: _________ 
Expiration Date: _________ 
Signature: ______________ó 

 
We think this is a fabulous 
idea. Anything that facilitates 
the clientôs payment process 
is a plus. Regarding credit, 
see apology below. Contact 
us with another clever idea 
and weôll thank you twice 
next time. 
 
BillBase3  
File Organization  
 
ñI created a subfolder in 

the ItemizedStatements 
folder and named it 
óClosedô. I use the folder 
to store the itemized state-
ment files of clients whose 
cases are finished. That 

leaves the ItemizedState-
ments folder with active 
clients only, making it less 
cluttered and the active 
files easier to find.ò 
 
Another great idea by an 
anonymous author. Appar-
ently, Ernie was so busy 
helping Jennifer, he forgot to 
get your name. Rest as-
sured, the women around 
here will make sure heôs 
adequately reprimanded. 
Your setup ensures the 
Closed folder is always 

backed up and you can eas-
ily ñreactivateò a file by drag-
ging it back to the parent 
folder. Way to go! 

TO :  TEC HN IC AL  SUPPORT  

ñA file name can 
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BookBase3  
Exporting Report to Micro-
soft Excel  
 
Is it possible to export 
data from BookBase3 to 
something with more pow-
erful financial and analyti-
cal functions?  
 
Yes, you certainly can ex-
port data from BookBase3 
into a spreadsheet program 
like Microsoftôs Excel. In 
fact, every month we do just 
that when we prepare our 
monthly sales tax report. 
Weôll explain the process in 
that context; however, the 
principles we discuss can 
certainly be easily applied to 
other functions. The transfer 
of data from BookBase3 to 
Excel only takes a few min-
utes. 
 
1. Create a Report.  
 
The first step is to create a 
report in BookBase3 using 
the Create Report button on 

the tool bar. When the Cre-
ate Report  dialog appears 

we complete the five steps. 
First, we give the report a 
title, usually ñMonthly Sales 
Report.ò Second, we enter a 
range of dates, usually the 
first day of the month 
through the last day of the 
month. Third, we press the 
Multiple Accounts button 

and select those accounts 
we want to get entries from. 
If you donôt use the Account 
field in BookBase3 , you can 
simply click on the All Ac-
counts button. Fourth, we 

click on the Select Transac-
tions button and select All 
Payors, on the Type tab we 

check Income. This makes 

sure that all income transac-
tions are included in the 
report. Finally, we leave the 
Subtotal by field set to 

Don¸t Subtotal. If youôre 

setting up the kind of report 

youôll use more than once, 
you can click on the Save 
Report button so that you 

wonôt need to set the report-
ing criteria again. With the 
report criteria set, we can 
click on the View button. 

This causes BookBase3 to 
create a report that is dis-
played in NotePad. 
 
2. Save the Text File.  
 
Once the data is in Note-
Pad, we strip the file of eve-
rything but the column head-
ers and the data itself. This 
means deleting the horizon-
tal rules, the title, subtitle 
and total at the bottom. 
Complete step 2 by saving 
the file as an ASCII (TXT) 
file. 
 
3. Import the Text File  
 
The final step in this process 
is to start Excel and open 
the text file you saved. Usu-
ally this will involve navigat-
ing to the proper directory 
(where you saved the ASCII 
file) and selecting TXT as 
the File Type  in Excelôs 

Open dialog. When you click 
on the Open button, the Text 
Import Wizard will auto-

matically appear. The Text 
Import Wizard has three 

pages. The first page re-
quires that you select the 
type of text file. The correct 
answer is Fixed width . 

Then, click on the Next but-

ton. The second page of the 
Wizard asks you to show 
Excel the exact widths of the 
various fields. Excel will take 
somewhat accurate 
guesses, but we usually 
make some corrections by 
dragging the little arrow 
heads on the column title 
bar to either the left or right 
depending on the actual 
width of the various fields. 
When you click on the Next 
button, you are taken to the 

last page of the Wizard 
where Excel wants to know 
what type of data is in each 
defined column. We usually 
leave this alone on the Gen-
eral setting and Excel does 

a reasonable job of guess-
ing what type of data is in 
each column (i.e., numbers, 
text, dates, etc.). When we 
click on the Finish button, 

the data appears in Ex-
cel ,ready for further action. 
 
Official Bankruptcy 
Forms, U.S. Estate Tax, 
Basic Ohio Probate Forms 
and Ohio Estate Tax  
25 Page Limit  
 
Is there a limit to the 
amount of data you can 
enter in a worksheet?  
 
Yes and no. At the outset, 
we should clarify that when 
we refer to a ñworksheet,ò 
we mean any database 
worksheet in any of the pro-
grams listed in the above 
header. This, however, ex-
cludes the General Infor-
mation Worksheet that ap-

pears in the probate pro-
gram. The ñnoò part of the 
answer alludes to the fact 
that the database work-
sheets are limitless in terms 
of the number of entries you 
can make in them. One limi-
tation is that a single re-
cordôs description cannot 
exceed 4,096 characters 
which is usually not a prob-
lem. The ñyesò part of the 
answer refers to the fact that 
an individual page, form or 
schedule cannot exceed 20 
pages in length. In the case 
of the Bankruptcy program, 
for example, each form or 
schedule that makes up the 
voluntary petition can be up 
to 20 pages in length. Con-
sequently, a voluntary peti-
tion can be more than 100 
pages because each sched-
ule (A through H) can be up 
to 20 pages in length. 
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Youôre printing merrily away 
on your laser printer and the 
pages start coming out with 
white streaks. Time to re-
place the toner cartridge, 
right? Maybe not! Weôve 
squeezed about 500 more 
pages out a cartridge simply 
by shaking the cartridge 
from side to side. The thing 
to keep in mind is that the 
toner must be spread 
evenly along the horizontal 
plane of the drum. So, itôs 
important that, after some 
vigorous shaking, you 
shake the cartridge from 
side to side to make sure 
you havenôt thrown the 
toner to one side or the 
other. Remember, the goal 
of shaking the cartridge is to 
distribute the toner evenly 
along the drum. 

How many times has your 
Windows desktop been lit-
tered with applications when 
you wanted to go back to the 
naked desktop for some 
reason. You can minimize 
running applications one by 
one, but thereôs a much 
quicker way. Take a look on 
your task bar to the right of 
the Start button. Youôll no-
tice a series of icons similar 
to the ones in the system 
tray to the extreme right. 
One of them, usually the 
leftmost one, is a picture of a 
desk pad with a paper and 

One of Windows most po-
tentially annoying features is 
AutoRun. There are many 

reasons for inserting a com-
pact disk (CD) into your 
drive and NOT wanting it to 
automatically start. A typical 
example is when you want 
browse the Windows CD 
without starting the installa-
tion process. If you want to 
permanently defeat Auto-
Run, you can start the Reg-

istry Editor (Regedit) from 

Windowsô Run Dialog and 

navigate to: 
 
HKEY_LOCAL_MACHINE\SYSTEM\Curr
entControlSet\Services\Cdrom 

 
Then change the AutoRun 
key from 1 to 0 (zero). If you 
like AutoRun for the most 

part, and only want to stop it 
once in a while when youôre 
inserting certain CDs, hold 

the j  key down while 

youôre inserting the CD and 
keep holding it down for 
about ten seconds. 

pencil. Clicking on this but-
ton minimizes all applica-
tions to the task bar and 
gives you the empty desktop 
you were looking for. 

your results contain an ac-
tual reference to civil rule 21 
and are not, for example, 
civil cases that just happen 
to use the words ñruleò and 
ñ21ò somewhere in the text. 

H I N T S  & TR IV I A  

ñIf youôve ever 

looked over a 20-

page contract trying 

to spot changes, 

youôll really 

appreciate this 

feature.ò 
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Stopping 
AutoRun  

Showing Off 
Your Desktop  

Shake It Up  

One of the single, most ef-
fective ways to give your 
searches more precision is 
through the use of quotation 
marks. If you type Civil Rule 
21 without quotation marks, 

youôll get hits of articles that 
contain the word ñcivil,ò the 
word ñruleò and the word 
ñ21ò regardless of whether 
they are used in context 
with each other. If you 
search for Civil Rule 21  and 

use the quotes, your results 
will be articles that contain 
the phrase ñCivil Rule 21.ò 
Therefore, you can be sure 

Quote Me On 
That  

Here a nifty trick for 
Word users. Have you ever 
given a document to someone 
and, upon getting the docu-
ment back, wanted to know if 
any changes were made? 
Word has a wonderful tool on 
the Options menu that does 
just that. You can open your 
original document, then click 
on the Tools menu, then on 

Track Changes . Track 
Changes  has a submenu con-

taining the item Compare 
Documents ... . When you 

select Compare Documents 
±, a dialog box appears 

where you can select the 
document you want to com-
pare the opened document 
against. After you select the 
document and click on the 
Open button, Word quickly 

compares both documents 
and highlights in red any 
changes in the original docu-
ment. If youôve ever looked 
over a twenty-page contract 
trying to spot changes, youôll 
really appreciate this feature. 
If youôre sending a document 
back and forth between two 
law offices, Track Changes 
can make things easier on 
both offices because Track 
Changes also has another 

submenu item (Highlight 
Changes é) that highlights in 
red any changes that another 
person makes to your docu-
ment. Again, this makes any 
modifications easy to spot in 
an instant. 

Ch-, Ch-, Ch-
Changes  
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ORDER  FORM 

Puritas Springs Software 

The Cleveland Trust Building 
P.O. Box 360170 

Cleveland, Ohio  44136-0003 
440-572-7645 

Purchaser Information: 

_________________________________________________ 
Individual or Firm Name 

_________________________________________________ 
Address 

_________________________________________________ 
City, State & Zip Code 

_________________________________________________ 
Phone Number    

_________________________________________________ 
email  Address 

_________________________________________________ 
For VISA/MC Orders Only:  Card Number 

_________________________________________________ 
Expiration Date 

We accept VISA and MasterCard orders  
by telephone for same day shipping . 

For up to date products, prices, and remote assistance 
please view our most recent catalog. 
 
We thank you for your support! 
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The Cleveland Trust Building  
P.O. Box 360170  

Cleveland, Ohio  44136 -0003 

 

Puritas Springs Software  

Phone: 440-572-7645 
email: email@puritas-springs.com 

Serving law firms, courts and government 
agencies from Puerto Rico to Hawaii. 

Puritas Springs 
Software  

In This Issue 

The means to determine who in your law office is the weakest link; a crab session in Digital 

Inklings; a new page called Inbox that highlights reader’s comments and complaints; and a new 

program called HUD Forms for Windows that automates completion of HUD Forms 1 and 

1A—Settlement Statements. Check out the super, special price that is hundreds of dollars less 

than the competition! 

 

2002, Et Seq. 

We didn’t do everything we had hoped to do in 2001 because there were so many changes in 

laws that affected existing programs. Some legal forms that had remained unchanged for dec-

ades were amended with days of each other and consequently we were left with little time for 

the development of new programs. Now, our immediate concerns are updating the Franklin 

County Probate Forms program and scanning our list of customer requests to see what new 

software our users want most. If you have a wish list, nowôs the time to give us a call. 

 

Your Privacy Is Paramount 

Don’t be afraid to send us your email address. We promise not to inundate you with junk 

emails. In fact we send only two or three bulk emails in an entire year. We mostly use the email 

addresses to send notices of new releases. We also use email for revision notifications. We 

never sell your email addresses to third parties. Also, we never sell or give out our customer 

list—no names, no addresses, no phone numbers, no nuthin’. 

Weõre On The Web 

www.puritas-springs.com 
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